Tips & Tricks to

mprove Efficiency,

Patient Management,
& Cash Flow

"Block & Biggs Road Show

= For copy of presentation go to:

http://blockandnation.com/blockandbiggs

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Who Are We?

"Bradley M. Block, M.D., FAAFP

= Family Physician in independently owned, four physician
Family Medicine group in Oviedo, Florida

="eCW User for 12 years
="William “Reddy” Biggs, M.D., FACE, ECNU
" Endocrinologist in independently owned, forty-two provider
Internal Medicine Multi-Specialty group in Amarillo, Texas
=eCW User for 10 years
= Board Certified in Clinical Informatics
" CPT reviewer for AMA
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Why Were We Asked to Speak?

=mBoth of us:

=Spoken together at NUC since 2008

=“eClini-Geeks” on the eCW Web User’s Forum for
assisting users w/ expert eCW advice

= Dr Block — written over 1,600 posts

= Dr Biggs — written over 3,000 posts & is a Forum Moderator

mBeta testers for new modules & versions of eCW
sAttested for EHR MU Bonus Stage 1 & 2: 2011 - 2015
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Goal of Our Talk —y

T
sStreamline Your Office Workflow & Transform
Your Practice into a Modern Platform of

Patient Care to Meet “Triple AIM” Goals by
Maximizing Tools Available to You

"| ots of New ldeas
"\ake Note of at least 3-5 Things Presented

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Why Bother to Implement Changes —
How Does This Benefit Me?

ncrease Efficiency of Providers & Staff
mprove Documentation of Care

Enrich Quality of Patient Care

“nhance Patient Engagement & Satisfaction

mprove the Health of your Patient Population
=Save Money & Boost Income

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Overview of Our Presentation

mShare Tips, Tricks & Examples
"Front Office
=\Mid Office (Medical Providers)
=Back Office (Billing & Finances)
=Full Hour of Ideas to Share

eClinical Works1 .

mQuestion & Answer Session at the End

=\We’ll stay after as long as it takes
B\Vlake notes so you don’t forget!
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Our Theme:
Customize Your Daily Workflow in eCW
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Front Office & Mid Office of Antiquity
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Front Office & Mid Office of the Future

ﬂEHill‘l p.-u-ﬂ'.- o marezi’ AT
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The Kiosk Has Arrived....

Welcome to Dr.Biggs's Office .

Check-in has never been easier!

Self Check-in from Kiosk

Touch to begin

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




More Than Just a Check In Device

11:02 AM

) o 0/g812016

lfcg Ot

Current Insurance  Verify Insurance Showing pharmacies in and around
AMARILLO

nitial ietter of pharma

Please validate that your insurance information is correct.

Insurance Name MEDICARE NOVITAS SOLUTIONS

Insured Name JULIA, TEST

Relation Self - patient is the insured
Wal-Mart Arma Neigh SE34th
Group Name 203 s

Subseriber No MMM Walgreen's Ama 34 Osage
i 4TH AVE, NEC of Osape and 3

green’s Ama 34th Bell
H

Is this insurance information valid? Walgreen's Ama 45 Western

eClinicalWorks, 2016. All rights reserved

Version 2.00

B ePayment Transactions

Search By:
Fadiity All [v] Posted By :

Patient : Date Range :

Set Primary Pharmacy

Payment# : Status :

Trxs : Type : Z
1 Re

1 emMr [ patientportal [ Kiosk m | Search |

al Time Search (RTS) Are you sure you want to set your Primary Pharmacy?

Facility Trx# Amount Date & Time
$25.00 Fri 2016-10-07 at
an.nEn A

William C Biggs MD
william C Biggs MD % $35.00 Thu 2016-10-06 at 01:29
William C Biggs MD $45.00 Thu 2016-10-06 at 10:44

william C Biggs MD C " t P ts $35.00 Thu 2016-10-06 at 09:41)
william C Biggs MD o ec aymen 8 $15.00 Fri 2016-09-30 at 09:32:
William C Biggs MD 4 $29.16 Fri 2016-09-30 at 09:11:
william C Biggs MD by KIOSk $40.00 Thu 2016-09-29 at 03:14
William C Biggs MD 8 $30.00 Wed 2016-09-28 at 01:1]
William C Biggs MD 2 $20.00 Tue 2016-09-27 at 11:09

6700 WEST 9TH, AM
Phone Humber: 806-158-0331

{ Tell injlingh Tojl Tojlis

DD

E

s

william C Biggs MD $30.00 Mon 2016-09-26 at 03:5
william C Biggs MD $35.00 Mon 2016-09-26 at 02:3
William C Biggs MD $0.01 Mon 2016-09-26 at 01:4]

s

18

30T I 30 I IR IR IR

s

7 Windo
h, O company @
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Consent Forms Done the Easy Way

10:48 AM

E) rossmm 10/09/2016

Start Over

Hello, WCB Development. Please sign the consent...

Potter County Texas Venue Agreement for
any Health Care Liability Claim

TEST, JULTA, 53 Y, F o) /s
Parties: A STREET MEDICARE

CLICK TO EDET
Acc Bal: $20.00
Gua

SECURE NOTES
Language: Italian
‘The Parties to this agreement are:

H:806-236-2815 Translator: No
M:806-236-2815

DOB:01/01/1963
hitesh.t@echnicahwor

Medical Summary | CDSS | Alerts | Labs | DI | Prc

1. Amarillo Medical Specialists, LLP and all Amarillo Medical Specialists staff Physicians, Nurse Practitioners, and Physician Assistants

(collectively referred to as “Physician”); and ” o - T
2. You, s signed below. (“Patient”. sedures. || Growth Chart | Imm/T.In] | Encounters | Patient Docs | Flowshee
- Document Details Progress Hotes
Definitions:

Options iﬁ
W Reviewed

[Potter County venue
1. Health care liahilitv claim means a canse of action against a nhvsician or a nhvsician’s emnlovees for treatment_lack of treatment_or ather.

EMR Form

- | _Time Stamp
Description it

[~ Reviewed Doc and Lab
B r Logs

Assigned To

© eClinicalWorks, 2016. All rights reserved.
Version 2.0.0

Tag
Scanned By

Attached To

Facility
[EMR. form

Scanned Date [10/% /2016 <]

ER E
r [~ Fit To width

the Taws of the State of Texas will govern such dispute or claim.

| 5ot | toin | 8 Bobeck Seascn | 00| P | ik | Pt

Do el o | - \.-.ﬂ r_=

I Pt TEST, LI |
=1 A,
= Lk Dcmarts

Patient Name : TEST, JULIA

Severability Clause:If any of the terms, conditions, or provisions of
this Agreement are held to be illegal, invalid or unenforceable by any
court of competent jurisdiction, the legality, validity, and
enforceability of all remaining terms, conditions, or provisions wrill
not be affected thereby. Furthermore, in lieu of such illegal, invalid
or unenforceable provision, there will be added automatically as a

part of this Agreement, a provision as similar in its terms to such
illegal, invalid or unenforceable provision as may be possible and be
legal, valid and enforceable.

HIPAA ACKHOWLEDGEMENT AND REQUESTED RESTRICTIONS.

: 3 i hat you have recels Signed On:2016-10-09 11:01:039
Pofter Courty Verus

WCE D

Skgned On:

eClinicalWorks
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Use Kiosk Questionnaires

to Have Patients Write Your Visit Notes

— The Modern Version of Bubble Sheets
(Diabetic Questionnaire Example)

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Finished Visit Note
Generated by Patient Entry

=|mport Patient
Responses via

1. Diabetes Type 2
¢ tab{s) orally

History of Present lliness
Healow HUB O * Interim History (ACO): @

Hospitalizations no ER or hospital admission
a Refills needed today Yes (pt entry).

. Diabetes:
% " 5] — i 3 —
b utton e @ pen | eosd - Diabetes Mellims/ MetaboligSy
EE—— ally once a day et not following a dief(pt entry).

blet 1 tab{s) orally Exercise 4-5 times a wek (pt entry).
Menitoring Schedule tyfice a day (pt entry).

& 30 units Blood glucose Yes (pt en®TT.
Hypoglycemia Hypo reatment carried on person (ptentry).
Severe Hypoglyeoemia None have occured since last visit (pt entry).

Glucagon Kit No | do not (pt entry).
Neuropathy/Foot complications No calluses or ulcers

Diabetes education more than 2 vears ago (pt entry).

Patient reports that No new problems today (pt entry).

1 1 et 1 tab{s) orally Digbetes:
Qu e St | O n n a | re Home glucose monitoring Results of home BG Monitoring ara:

¥ onoe per day &
onee aday Breakfast 55

Lunch g9

Saved in Patient @ s Notation Marks All Kiosk Responses

Noe

D O C U m e n t S ] E:I_l'p-:-gl:-'cemic episodes one a week (pt entry).

Exercise type walking, bicycling indoor or cutdoor (pt entry).
Last eve exam 3 - 12 months ago (pt entry).
Eve Professional Broome (Beddow Martin Hoang Nossaman OBrien Williams] (pt entry).

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Create & Edit Questions for Patients to
Answer at Check-In Using the Questionnaire
Designer, then Link to Specific Visit Types

B i

Alerts & I I

Immunizations{Therapeutic Injections (Design the questions and options that will be carried by the guestionnaire. The tree view contains the

vikals Sections and their items which will be linked. The data grid on the right provides details on information
appearing on the dynamically created questionnaire page such as to which section and item is the guestion
linked to, what are its options and is it a single or multiple choice. New items can be added from the tree by
Miscellaneaus Configuration Cptions double-clicking on the items.

lowasshy
Flowshests . Page 1/1 »> | SRS  FaoeHeader I Edit Row II Delete Row |

Flowsheet Manager -~
[_1 Review Of Systems Seq No Linked Section Linked Item Options Selectic
Sp— L1 Social History it HP Hypoglycemia sym... Yes, ND Slngle
(1 Family History 2 _ tingling/numbness/
W Yisit Codes [_] Past Medical History
Specialky Forms
Bubble Sheet Designer Allergy/Asthmay 53] Questionnaire Editor
Guestionnaire Designer [:l BP Check Visit
-[_] cardiology
[} Questionnaire Setup -] Constitutional Heading: |Endocrinnlogy
--[_] Depression Scre i
-] Dermatology Huestion: |any tingling, numbmess, or burming sensation in hands or feet

[:| Endocrinclogy Options: |ves Mo

Labs, DI & Procedures

Link, Rux

Question Details

[(—“ Create a New Questionnaire

I i i J -[m fatigue

WS (uestionType: _ _ . .
(" Edit an existing Questionnaire weight lo: ¢ Single Choice " Multiple Choice

flushing ™ Free Text [Data collected from free text option goes to notes section - this is not
(" Delete a Questionnaire DDWUFIE

polydypsi
appetite ¢

myalgias .
-l tingling/n =

Home Fin ¥ o ]
< >

L Inzert item into Questionnaire JI Freview Save | Cloze |

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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A Kiosk Critique

"mproves front office efficiency
=Questionnaires:

=Great time saver for providers & staff
"mport answers error free

®Can make changes instantly as desired
="Need to tell patients they can scroll up

"Experience so good - ordered more

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




For non-Kiosk Users
& for Complex non-Kiosk Friendly
Forms - New |ldeas for eCliniForms

2

eCliniForms
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Improve eCliniForm Efficiency & Accuracy -
Automatically Insert Patient Name & DOB

(need to be sure Item Key turned on)

&, Ink document. Pages - 1/1 . Ink document. Pages - 1/1

Sayeato Attach To . Multi-Page 3 = Save To Attach To _| || Muli-Page
: Patient . v‘ Inking Bubble She : : 7 Local \i; Patient Ll—iJ Inking Bl i

BLOCK & NATION, P.A.
FAMILY PRACTICE

Bradiey M. Block, M.D. A. Notifier: BLOCK, NATION, CHAS

Craig P. Chase, M.D. Susan G. Sm

PROCEDURE CONSENT FORM 2441 W. SR 426 STE 2011 O
Eatient Name: Demo,Patient DOB: 05/20/1969 | Acd

Eﬁti,ent Name: Test,Adiel DOQOB: 08/11/1955 \l
— Uaie or Froceaure

Paticnt Name

B.Patient Name: C

Procedure Shave Biopsy (Biopsies)

STATEMENT OF REQUEST Advance BGHEfiCiary Notice

1 The nature and purpose of the procedure, possible alternative methods of treatment, the risks in . i ' .
possibility of complications have been fully explained to me. | understand that the reasan for the ._._NOTE If Medicare doesn't pay for D

perfarmed by the Doctor is for: cancer screening and / or removal of irritated skin lesion(s) MEdicare does not pay for everything even some ca
good reason to think you need. We expect Medicare

I have also been made aware that there are other possible risks such as pain, loss of blood, infe
recurrence of this same problem that are attendant on the performance of surgical procedures o
understand that the practice of medicine and surgery is not an exact science and thus | acknowlg
have been made to me concerning the successful results of this procedure. The Doctar has info

following nisks and consequences are also associated with this procedure: 1)) ITEM/SERVICE

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Use Topaz type Signature Device to
Automatically Insert Patient Signature into
eCliniForm Signature Box

. Ink document. Pages - 1/1

Save To Attach To L] Multi-Page
Local L& Patient L:]J h Inkingg Bubble Sheet

H Addltlonal Intormatlon Zapkure signakure from signa
This notice gives our opinion, not an official Medicare de(
this notice or Medicare billing, call 1-800-MEDICARE (1-800-

Signing below means that you have received and understand

L Signature:

According w the Paperwork Reduction Actof TH95. nw persons are reguired Lo respond wa collechio

This notice gives our opinion, not an official Medicare dle
thls notlce or Medicare billing, call 1-800-MEDICARE (1-80(
at you have received and understant

According G the Paperwork Reduction Act of THYS. no persons arce reg ired te respond W a colleet

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use “Update” Function in eCliniForms to
Customize Location of Data Inserted by eCW

=Use “Patient Info Loc”
X-Y Axis to imprint
patient name at desired
location on forms

"Use “Signature” X-Y
Axis for Signature
Device to insert
patient’s signature at
desired location on
forms

Signature ¥ 1278
Fatient Info Lo I 473
Fatient Info Loc ' I 53

Block, M.D. -- William “Reddy” Biggs, M.D.




Tips for eCliniForm X-Y Axis Location

8 X = Horzontal Ax(s

sHigher #s move Location farther to Right

mY = Vertical Axis

"Higher #s move Location farther to Bottom of page

| ocate final Axis location to allow enough
space for long names

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Another Way to Have Patients Populate
Notes for You
- Healow Lends a Helping Hand

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Have Patients Use Healow Trackers
to Provide Data for their Visits  yumd

- Click on Healow HUB Icon to open up Tracker Data

B3 healow hub-Deme, Patient M B3 healow hub-Demo, Patient M

. 123-456-7890 ¢, 123-456-7830

Personal Health Record Trackers Personal Health Record

Trackers
Blood Sugar

Before Breakfast 5%
After Breakfast —
Before Lunch - L
After Lunch Min Pre Meal Glucose
Before Dinner User Entered: Thursday, Sep, 13, 2016 =
After Dinner Clucose: 114 mg/dL Max Pre Meal GI
Before Other 5 ]
After Other

Average Pre Meal

Average Post Meal

Min Post Meal Glucos|

0 2 75 Max Post Meal Glucose
ma/dL 09714 09/15

[ 9B Clucose | - Glucose

Calories Calories

CALORIESOUT Average Reading
Max Reading 120/

CALORIESOUT
0 mmHg

Min Reading 118/66 mmHg

ories burned

eClinicalWorks
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Use Healow Trackers to Copy & Paste
Patient Provided Data into Visit Notes

HPI: =
Hypertension / BP
BPF's outside our office Healow Home BP log:
Blood Pressure * Average Reading 120/68 mmHg
* Max Reading 120/70 mmHg
s Min Reading 118/66 mmHg.
Endocrinoclogy
Home Fingerstick Blood Sugars Healow Home BS log:

s Average Pre Meal 118.67
. o « Average Post Meal 0
Min Reading )
' « Min Pre Meal Glucose 110
+ Max Pre Meal Glucose 130.
Current Medication:
Taking
s+ metformin 500 mg tablet, extended release 4 tab for Di

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Healow Tracker Tips

=Can only be viewed o
(Cu rrently) from ViSit nOtes Use Cart to Link Automated Device

" Patients can manually \ 7

as recorded on 09 May, Monday

e nte r’ O r u Se th e Ca rt to iHealth Wireless BP iHealth Wireless BP

0% change in last 30 days Monitor Wrist Monitor

link & “Setup” a device to
a u tO m ate d ata e nt ry UnderWeight @ Normal @ OverWeight @ Obese e

| If not using Healow partner CﬂﬂclleleretoMamﬂaﬂﬂyAdd#‘s ‘I—I

Systolic/Diastolic

BG mohiter; Usesiliecls -

s recorded on 24 Sep 2015, Thur..} Withmgs Wireless

Manually” link to add 0

Heart Rate

BlOOd G | UCOSG Suga r past 90 days reading o
tracker option to “My o S € e @ e
TraCkerS” Screen (I’T“SSIng Heart Rate

b d efa U It) Floors Blood Glucose

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Chart Like a Pro

~ -
LR ™
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Patients Can’t Do All the Work for Us
- Top Speed Ahead

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




— Set Templates Default to “Generic”

[ Settings for Block, Bradley M, M.D.

ump to Your “Favorite” Generic
Templates Quickly

5 Copy And Merge Templates

( Defaults 2 T My Resources T

Warnings T Messenger eClinicalMabile

My Providers T User Settings

T Physician Reference T Views

Show /Hide

Go to File>Settings>"My Settings">Default tab

Default Superbill

Default Lab Requisition Form
Default Imaging Requisition Form
Default UOM in Growth Charts

Default Style in Progress Notes
Default Signature Pad

Default Timeout for Server C ication

|General

|General

|General

|Standard

|Bulleted

L Lef Lo Led Led Lo

|Topaz

| Default Progress Note Templates
[ault lumber of Visits for Dutgoing Reterra

L seconds (0 = default timeout)
&+ Generic Patient Specific

Default Payment Metheod in Co-pay Screen
Default New Patients Primary Service Location

Default Option for View All Reports

Default Screen for Lab/DI Review
Default Lookup Options

Cumulative eReport:

View All Reports - By Patient:

|

" Check " CreditCard {* Cash

|B|od<,Naﬁon,Chase,Smo|en Fam\lyl\'j

|By Patient (Unreviewed) j
@+ Reports (" View all reports (Unreviewed) Sort By |Order Date -

Lookup Option
|Order Date

Sort By Option
j ‘Order Date

Output Format

j |Regu\ar X5L j
j ‘Order Date j

|Order Date

Works P2P

Configure My Assigned Favorites

Copy My Settings CCMR Settings |

eClinicalWorks

eClinicalWorks

Template For
Patient |Test, Adiel A

Choose Template

Category |My Fawvorites

| * Generic

=]

"~ Patient Specific Test, Adiel A

Find | Contains

Facility |all

=] Block BPH

7| Block BPPV

7| Block Breast Ca Screen

7] Block Breast CA Screen w/ F-C US
,_1 Block Bronchitis

| Black BV

7 Black CAD

7] Black Chest Pain

] Block Chondromalacia of Patella
7] Block Chronic Pain

J_j Block CKD (mod stage 2: GFR 30-59)

=l

ﬂ Relation

=] [ea]

Add A= Favorite Merge Template | =

Encounter Date |Saturday, September 17, 2016

™ All Options

cC

HFI

Currenti edication
MedicalHistory
Allergies
SurgicalHistory
Hoszpit alization
FamilyHistory
SocialHistory
ROS

Yitals
Examination
PhyzicalE xam
Azzessment
Treatment
Procedures
Ob History
*Ray

Yisit Code
Labs
Preventivet edicine

P Db

IEREEONEEEROROOOO0O0O0O0ORKDO
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Use Templates to Standardize &
Expedite Test Ordering

B9 Copy And Merge Templates
T Assessment:

Patient |Demo, Patient M Encounter Date |Saturdav, September 17, 2016 Assessment: =

Choose Template » Coagulation defect, unspecified - D68.9 (Primary)

™ All Options

* Generic Category |all j

" Patient Specific Demo, Patient M Sel | Relation
Find | |Contain5 j Go

Facility |All |
| [prTemplate _________ __________________ [Access

] Block Influenza Screen with URI DX Public
,_'1 Block Insomnia Public
] Block Intertriginous Dermatitis Public
Btk e -Gttt Public
] Block Labs -Abnml TSH Public
] Block Labs -Anemia W/u Public
IB)| 5lock Labs -Coagulopathy W/U

:‘1 Block Labs -Diarrhea Stool Testing & TX plan Public
] Block Labs -high Calcium Public
] Block Labs -high LFT f/u Public
7] Block Labs -High MCV on RBC's Public

N

cC

HFI

Current edication p I an:
MedicalHiztory

Hllergies Treatment:

SurgicalHistory . .
Hospitalization Coagulation defect, unspecified
FamilyHistary )

SocisHistory Lab:-Homocyst(eling

\H,q?ai Lab:-Prothrombin (Factor II) 202106 mutation

reninaion Lab:-FACTOR V (LEIDEN) MUTATION ANALYSIS
fssassment Lab:-PROTEIN S ACTIVITY (frozen)

Treatmet

= Lab:-PROTEIN C ACTIVITY

Ob Higtary

ﬁ.ﬁ.fyc ; Lab:-LUPUS ANTICOAGULANT EVALUATION WITH REFLEX

Labs Lab:-ANTIPHOSPHOLIPID ANTIBODY PANEL (anticardiclipin AB's)
Lab:-Factor 8 activity

ﬂ % Lab:-Activated Protein C Resistance (APC) Screen
Add As Favorite Merge Template |.| Close Lab:-AntiThrombin ITT Activity

IRRRRNORERROROOOO0OO0O0ORDO

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Use Templates in TE's to

Order Tests or Start TX Plans
(through Virtual Visit)

D@L B E L 2
[~ Pregnant [ E=r'E-a:=tFeedirTen-.pl.ateu:ur-;.- Yerifie

Message] Rx | Labs/DI | Motes | Addendum | Log History ‘

Assessment:
Anemia, unspecified - D64.9 (Primary)

Plan:
Treatment:

Anemia, unspecified
Lab:-Folate (Folic Acid)
Lab:-Ferritin
Lab:-Vitamin B 12

I =k 0 war MfF b rhe inde saekbie e d

Erint Script Send R Print Report Progress MNotes

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Carry Forward Chronic Medical Problems
with Patient Specific Templates
- Or use Carets to Pick & Choose Items

i, Copy And Merge Templates

Template For

Choose Template

Assessment:
Assessmer

Recent encounters of: Block, Bradley M [ 1 aAll Providers
] 0312612016 45 0V ANNPETC Block, Bradley M
Treatment: ype 2 diabetes mellitus with Diabetic Nephropathy - E11.21 (Primary)
Hypothyreoidism, unspecified - E03.9
D Insomnia, primary - F51.01
Hypertensive heart disease without heart failure - 111.9
Lab Reports: [] GERD - Gastro-esophageal reflux disease without esophagitis - K21.9
Preventive Me O Allergic Rhinitis, unspecified - 130.9

ype 2 diabetes mellitus with Diabetic PolyMeuropathy - E11.42

| Copy |

= Termnplate

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Fix Charting Errors - Overwrite with “Blank”
Notes Template (using “Copy” Function)

Choose Template

¥ Generic Category [all

" Patient Specific Dermo, Patient M

i I Contains

Facility |All

&dd As Favorite

I Copy Template a

eClinicalWorks

Relation

Public
Public
Public
Public
Public
Public
Public
Public
Public
Public

[P

I- All Options

O
] C
] M
0 2
O
O
O
O
]
O
O

[

Bradley M. Block, M.D. -- William “Reddy” Big




Just What the Doctor Ordered...

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use Order Sets to Standardize
Testing & Treatment Plans

mProviders & Staff see what should be done
for medical condition & when done last

mJust check boxes & “Order” anything due

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create a “Favorite” Order Sets List for
Easy Access from Right Panel

Demo, Patient 57 ¥, F as of 10/02/2016
My Favorite Order Sets

Allergies, Asthima, COPD -
Patient Schedule :;;’:}i;&?;ﬁﬂ?g:;m e ommunity Meaningful Use | Lock Help
B3 OrderSets | Arthritis and Gout .
Back Motk and Racicutar Pain _ orlong ists
Breast Imaging Diabetes and Renal
Concussion
Deprassion, Anxiety
Diabetes and Renal Thyroid .
Diziness-BPPY I BT MEASURE: (V7 QUICK ORDER SET: YES Hypertension and CHF
Hip and Knee Pain
DIAGNOSES {Hypertension and CHF MESSAGE
Hypogonadism

z;‘;(':‘;f;; Hipomagnesemiz @ Scroll Down OS List, and Click on "Add to My Favorites" @ Well PE

IGT
GENDER (TR |nsomnia, RLS

Lipids and CAD 1
& rv;sg'\ir;nmmem\a‘Neumpatny s “ 1 Ankle’ FOOt’ and Leg Spraln

MusculoSkeletal Pain and Spasm
Pulmonary Nodule
El

[“Order " Browse | =
= Shoulder, Eloow, and Wrist Pain Allergies, Asthma, COPD
B O N N e e e T
o B

accines mg) 1 tab(s) Q am once a day 30 day(s) 3 orally ﬁ;ac::slsﬂgs:wal\v R m H BEICI(, NECk, and Radicular

Vit D Defic and Osteoporosisipenia

O 2% LeWEB SITES ma) 1tabin AM once a day 90 day(s) 0 orally tablet - Other.»\mmns H p-EIiI"I

Well Child Care [¥)
Well PE

[ RssignedTo: [Eeck. Badey ~ RS Ju— Shoulder, Elbow, and Wrist
L r——L e _
[] -TSH (Thyroid Stimulating Hormone) Quest, Labcorp, Labcorp OG, . - - m [Otheradions v Hf & Pain
[] -T4FREE (Thyroxine) Quest, Labcorp, Labcorp OG,... - - - = ) )
[ -T3 TOTAL (Triiodothyronine) Quest, Labcorp, Labcorp, La... - - - = Y] H'P and Knee Pain

Search for Order Sets

Lipids and CAD
Well Child Care

IBS, Celiac, Abd Pain, GI

Memory, Dementia,

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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eClinicalWorks

Use Right Panel Order Sets to Insert DX
Codes & TX Plans into Visit Notes

Quick Search &7

E11.36 Type 2 diabetes mellitus with diak ~
E11.39 Type 2 diabetes mellitus with othe
E11.44 Type 2 diabetes mellitus with diak
E11.59 Type 2 diabetes mellitus with othe
E11.621 Type 2 diabetes mellitus with foot
E11.638 Type 2 diabetes mellitus with othe
E11.65 Diabetes type 2, uncontrolled
E11.40 DM type 2, uncontrolled, with neu
E11.9 Diabetes

DM Type 1 Diabetes Mellitus with

DA Tuoad Diabatac Mallibc it

" o o

o ] O g S

W
o |

Click "OS"
Buttonto
Pop Open
DX List

History

Test. Adiel 61 Y. M as of 09/24/2016
= My Favorite Order Sets

Diabetes and Renal

Hypertension and CHF

Well PE

Click on "OK" to Insert DX & Pop Open OS

to Link TX Plan Options All at once

Assessment:
Assessment: 7
e Diabetes type 2, uncontrolled - E11.65

Plan:
Treatment:
Dizbetes type 2, uncontrolled

Back, Neck, and Radicul
Pain

Shoulder, Elbow, and Wri

Start Metformin tablet, 1000 mg, 1 tab(s) for blood sugar, orally with meals, twice a day, 30 day(s), 60, Refills 5

Lab:-HEMOGLOBIN A1C

Lab:-CMP (comprehensive metabolic panell w/GFR
Lab:-HEMOGLOBIN A1C (Ordered for 12/16/2016)
Lab:-HEMOGLOBIN A1C (Ordered for 03/16/2017)

Lab:-CMP (comprehensive metabolic panell w/GFR (Ordered for 12/16/2016

Lab:-CMP (comprehensive metabolic panell w/GFR (Ordered for 03/16/2017

MNotes: Low carbohydrate diet emphasized i.e.- South Beach Diet, weight loss, increase exercise , Counseling done on
risks/benefits/advantages of patient’s therapies & treatment options. Educated on Diabetes Mellitus. Labs to be done every
3-4 months.Follow-up: Ophthalmologist or Optometrist annually for eye exam.Warning given - Metformin: D/ C x48 hrs if IV
Dye injection, & avoid increased EtOH intake to prevent toxicity. WARNED strongly of: Diabetes dangers for increased MamMm,

i.e. DM Complications, especially with poor control.

eClinicalWorks

B3 Order Sets

Search for Order Sets

ERDER SET: |Diabetes and Renal v I ICEEE MEASUR|
DIAGNOSES (TRIGGER): MESSAGE
DIAGNOSES (LINKED):

AGE (TRIGGER): ~
GENDER (TRIGGER):

Bydureon 1 wial injected once weekly|

1 tab(s) for

€2 Invokana Diabetes

once a day

ol 1 tab(s) for
o q :
Pioglitazone Diabetes once a day

Description

TX Plan "Notes"

can be added too
(below edge of screenshot)

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Labs, DI, Vaccines, On My
- Other Ways to Customize Your
Workflow for Orders

he

Labs/Irnaging

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Zoom through Ordering New Tests by
Using Patient Specific “Previous Orders”

=See All Past Labs, DI & Procedures

sAutomatically Adds & Links DX Codes previously
Associated with that Order

= (caution — make sure last order not done with ICD9 code)

B3 Manage Orders

Current Meds Add New Rx Add New Order

Lookup: IR - : (| ERETA v pe: EEENMET| * Otb @ DT ® Procedure
Frev Dx
Lab Company:

O @ All O Previous Orders
Select all

le or Lipoprotein Fractiona..

DX Codes automatically < se, Total, Serum (€K ) : -
get added as each test, ] =
gets ordered - _ 0

ng term an..

H S |:|S |:|F IH Description

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create & Use Custom List of “Favorites”

for Ordering Common Labs, DI, Procedures

(& Use Lab/DI Button to Toggle Between Screens)
- But No Previous DX Linked -

| addveworder |
Lootup: I :: [Ty | EXTYINE vype: CECMNES % Olab 801 8 Procedure

Lab Company: _I g All ® Previous Orders

Order Name Lab Companies
-CBC w Diff h/h,rbec,indc,wbc, w/ PLT Labcorp, (
-CMF (comprehe e metabolic panel) w/GFR

-HEMOGLOBIN A1C

-Lipid Panel (TChol,Trig,HDL,LDL) w/non-HDL-C

-PSA , serum (refrigerate)

-T4 Free (Thyroxine)

-TSH (Thyroid Stimulating Hormone)

-Uric acid

-\it D, 25-Hydroxy, Total (for deficiency)

-Witamin B 12 Quest, Labcorp,

toocup: [ - : CI Iy | EXTUS ryve: CEZNNEL * | ®Lab ODI ®Procedure

DI Company: _ 2 All #® Previous Orders

Order Name Lab Companies
opy

MNE DENSITY of Hip, Lumbar Spine w/ FRAX Score SimonMed Rad Bi, CDI_Rad_Bi
rdiogram
Mammo DIAGNOSTIC BILATERAL DIGITAL W/ BREAST US
Mammo DIAGNOSTIC LEFT DIGITAL, W/ BREAST US as n
Marnry IAGNOSTIC RIGHT DIGITAL, W/ BREAST US as n

Med Rad Bi, CDI_Rad_Bi
Med Rad Bi, CDI_Rad_Bi
Med Rad Bi, CDI_Rad_Bi

ed Rad Bi, CDI_Rad_Bi
Med Rad Bi, CDI_Rad_Bi

ed Rad Bi, CDI_Rad_Bi
imonMed Rad Bi, CDI_Rad_Bi
snMed Rad Bi, CDI_Rad_Bi

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.

Us ABDOMENM COMPLETE

US BREAST- BILATERAL (& Axilla as needed;

US BREAST-UNILATERAL - Left ( illa as needed)
US BREAST-UNILATERAL - Right (& Axilla as needed)
¥Ray CHEST 2 VIEWS [PA/SLAT)

Wwwmwmwmumunwm

%]
=




Create & Use Custom List of “Favorites”
for Ordering Frequently Used
Immunizations & Injections

m Immunizations;T.Injections

Imm Schedule | Flu Schedule -

Delete

T Alll * My Favorites

Find Find
—~ i

Pneumococcal-23 (adult)® B-12, 1000 MCG
Prevnar-13- Pneumococcal® {enalog per 10 mg™
TDaP-Adacel/Boostrix-(11yrs & over)*-Te Phenergan (to 50 mg)*
Zostavax - Shingles Vaccine** PPD*

[Refused Influenza Vaccine or Deferred t

Rocephin per 250 mg™
[Refused Pneumovax Vaccine or Deferrec

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Your Own Individual Custom List
of Favorite Labs, DI, Procedures

z- sillimg Reports CCD Fax ePavment Tools Community Meaningful Use | Lock He

Alerts

="Go to EMR> Labs, DI,
Procedures> My Labs,

Jiagnoskic Imaging

DI, Procedures Favorites |l

Inst

=Use “Add” Button in
each Category to Create

mprehensive metabolic panel) w/GFR
LOBIN A1C
-Lipid Panel (T rig, HDL, LOL) w/fnon-HD
-PSA , serum (]
-T4 Free (Thyr
-T5H (Thyroid Stimulating Hormone)
-Uric acid

o o o o o o o

-Vitamin B 12

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use “Configure Categories”
to Create Custom Lists of Favorites
for Multiple Providers or Staff at Once!

=Go to EMR> Miscellaneous ®=Labs, DI, Procedures,
Configuration Options> Immunizations, Injections
Configure Categories>

Lab Orders, etc.

-Eilling Reports CCD Fax ePayment Tools Community Meaningful Use | Lock Help

& all Licensed Providers & all O

Alerts

Immunizations) Therapeutic Injections

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




More Remedies
For Managing Patients Efficiently

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Speed Up Scripts —
Customize Your Prescription Workflow

)

Prescriptions

8]

e
ePrescriptions

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Customized “Favorite” or
“Custom” Scripts for Commonly

Prescribed Meds to Avoid RX Edit Time

=Chronic Medical Conditions (DM, HTN, OA), Antibiotics,
Derm Products, and PRN meds w/ special instructions

"|nstructions, Medical Indication, Typical Quantity
Dispensed & Refills

"“Add as a Favorite” on the fly for future use

"Dosage Calculator

Gounces N |5 W

v ol v o2 we

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Pull Up “Favorites” with Customized
changes Quick & Easy & Ready to Use

®Can have multiple pre-configured Favorites for
each drug — shows up as more options to click
under single drug name

Type r'-1ultun'|F!_:u: « | Search| Starts With ~ | = Standard Show (" Standard|{™ My Favorites  Both |[M
i l

v Real Time [ Show Discontinued Rx Eligibility

F Drug Mam:| Strength
@__, ._IH Relpax 40 mg tablet
I-J H I|:+ 20 mg tablet
40 mg tablet

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize RX Edit Screen Pic Lists

" Dosage Calculator

Formulation Take Route o Duration_ Dispense
cream tab at bedtime |4 | lintravaginally fime a week 00
drops | tab every Al inlauenouch
ael 1 tab every PM
inhaler | tab for BP orally OTC
liquid | tab for Cholesis orally with food |
nasal spray ; i rectairy \
ointment | tab(s) subcutaneously once a day
solufion | i sublingual once daily
spray 1-2 caps topically (1 4-6 hours PRM

| | 1-2 pills as clirecizrw fopically to affecte| =] |& am

100 mg A4 altahlet q_|1 tab for Diab 72 |urﬂll1.r u.lnn[:e a day 7 )

* Combined length of Take, Route and Fregquency cannot exceed 132 characters. [Remaining Characters 98).
*¥ Custom Dosages are not shown by default. To Show/Hide Custom Dosages Setting follow the link:
MySetting --> Show/Hide Tab --> Custom Dosages in Rx Edit Screen

Rx: Januvia 100 mg tablet, TAKE: 1 tab for Diabetes, orally once a day, for 30 days, DISPENSE: 30, REFILLS: 3

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Customize the RX HX Screen —
See Complete RXHX in 1 Screen with 1 Click

+ Summary of: Septra DS 800 mg- 160 mg tablet

+ Summary of: Skelaxin 800 mg from ER tablet

+ Summary of: Sterapred DS 6 day pack 10 mg - 6 day pack tablet Mﬂdern Ulew
+ Summary of: Synthroid 38 mcg (0.028 mg) Brand Medically Necessary

+ Summary of: Synthroid 50 mcg (0.05 mg) Brand Medically Necessary

i, Select Medication

/7 Cur R~ R ByDate & RxByName, eRxRefil Synthroid Classic View

Phenergan with Codeine ;l | | | | | | | |

Prednisone 02/04/2 Refill 125 meg [ Brand Me 1 tabgan orally once ad: A0 days 90 Block Bra |
Propecia 1220842 Increaze 125 mog [ tablet 1 tab g an arally once ad:s 30 day:  Samples Block Bra |
Proscar 03/07/2 Increaze 112 mog [ tablet 1 tab g an arally once ad: A0 days 90 Block Bra |
Research-fsthma Anti-TSLP 195G maon 05/24/2 Refil 100 mcg [ Brand Me 1 tab G A1 arally once ads 90 dayps & 30 Block Bra |
Simwvastatin 02/09/2 Increaze 100 mcg [ Brand ke 1 tab O Al orally once ad: A0days 90 Block Bra |
Singulair 1072742 Refil 88 mca [0 Brand Me 1 tab O Al orally once ad:z A0days 90 Block Bra |
Sterapred DS 12 day pack 03/14/2 Increaze 83 mecg [0 Brand ke 1 tablz)  orally once ad:z A0 days 30 Block Bra |
Sterapred DS 6 day pack 03/24/2 Increaze 7B meg [0 Brand ke 1 tablz)  orally [J am 90 day= & 90 Block Bra |
Syrmbicort 111942 Start B0 rmcg (0 Brand Me 1 tablz)  orally [ am 30 day(z] 30 2008-11-1 Block Bra
S ynthroid

Valtrex
Valtre:x Zelect All Select All (Mo DDR} Clear all Show External Bx | oK I Cancel |

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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eClinicalWorks

()
Insurances
Pharmacies
Attorneys
Emplovers

Insurance Groups

Case Managers

Lab Companies

Buarantors

Provider Numbers

Data by Facility

Referring Physicians/Insurances
Refresh Counts

Mandatory Fields

Facilities

Facilities Additional Information
Facility Groups

User Groups

Templates

Action Template

Zip Codes

Management

Reconcile Interface Resuls

Interface Dashboard

Eruriby Sebtinn.

FaM O O

k, Bradley M 'I_I =3
| |

i, Settings for Block, Bradley M, M.D,

Seftings

Primary Practice

Merge Patient

Zhange Password

Local Settings

My Settings

[ Defauks 2 T My Resources T Warrnings [ s senger |

My Providers User Sattings T Physician Reference ] Yicws I
Left Panel Icons (¢ Modern Wew 1 Classic View
Claims Lookup " PrtsfRefunds & Pmbsfadiest |V Adjustment
R List View for Print and Fax + ModernWiew 1 Classic View
Alerts " CDss  Clagsic lerts [ Both
Manage Rx % Modern View  © Classic View
R Edit % Modern iew T Classic View
Patient Labs, DI and Procedure Hx % Modern View " Classic View
Cumulative Lab Report ' Modern view  ( Classic View
Formulary Rx Screen ™ Modemn Wiew (% Clascic View
Irnmsuinization and Flu Schedale i+ modern Wiew  © Classic View
Lab/D1/Procedure Order Screen & ModemnWiew 1 Classic View
Device DI Screen & Modern Wiew Classic View

0%

Progress Nobes popup Screens

(Increase

Apply Medication Summary Modern Yiew in

1

I Current Medications (Progress Notes)

I Current Medications (ManageR:x: - Modern View)
™ Progress Hotes Right Panel

™ R History (Patient Hub)

I Telephons Encounter

#Fr PN FE F5 FD FR FT FL

"M A FC

r@"OED:-DOrODTD.OMGE




Take Control of
Controlled Substances in Your Life

=Kick the Habit —
Stop Faxing & Printing Scripts

-Use EPCS -

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




e-Prescription of Controlled Substances

uElectronically Transmit All Schedule levels of
Controlled Substances in all 50 States

"Includes All Meds for Pain, Coughing, Anxiety,
Sleep, ADD, Testosterone Replacement

" Allows for Electronic Refills of ePrescription
Refill Requests

"\ost Pharmacy Chains including Mail Orders

"may have to educate some pharmacists....

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




EPCS Tips

"Registration & Identity ——
Verification Process patient Address
] 8/11/2009
= Allow ample time

Last Appt: 01/21/2015 06:45 PM

. ex : rovider [
*Have personal Credit Bureau Info |8 P

Provider Mame Black, Bradley

details handy —i.e.- mortgage & |—_ MLGREENS
aUtO |Oaﬂ payments Pharmacy Address |7403 ALOMA AVE

sWatch for Pharmacy EPCS  [REirieti e

Pharmacy

enabled Sym bOl Motes to Pharmacist
®Can Only Transmit Multum

or Medispan Drugs — No I
CUStom s WatCh for u =i 9 ’ Block,Bradley M

Prescription

=Create “Favorites” pre- T"“'
5 | o Start fgdderall
¥ configured for easy use

acetarminophen-hydrocodone

ax: 407-a77-

Browse ...

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Save Even More Time —
Stop Fax Refill Requests from Pharmacies

: Your Name Hfl?fle MD
Fax refill requests lower T e,
efficiency & productivity Amarillo, Texas 79106

I I EAR PHARMACY:
Insist pharlnaCIeS only i ‘
Due to the recent marked increase in the number of computer generated fax requests from

S u b m it refi | | re q u e StS vour company, we will no longer respond to them.
e | e Ct rO n i Ca | y ( | n Cl u d | ng E PCS) [ have found many of them to be requesting medidnes that are no longer on the patient’s

current medi cine list.

WO r kS fo r a | m a 1 O r Th erefore, please have the patient request a refill from us at the time of ther next
J office visit, and we can discuss it with them at that time_ K they need a refill prior to their
mext visit, they can come by our office or have the prescripti on mailed to them at no

p h a rm a Cy C q a i n S a n d m OSt charge; or faxed for anominal charge.

1 | Alternatively, wewill r dtorefill r hat you initiate via SureScripts_
mail order & independent Shhtar i ——
| O Ca | p h a r m a C i e S We hope that vou share our goals of encouraging our patients to be fully involved in their

medical ded sions, and therefore enhancing the quality of their medical care.

WO R D \/e rS i O n Of Lette r In th e future, please do not fax refill requests to us, as we will not be replyingto them
I

Please contact the patient and request they discuss their fill s with us at their next visit.

on Block&Biggs Website -

Jane Smith, MD FACP

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Stop Pharmacy Faxes Efficiently
- Simplify the Process

=Create eCW “Letter”
from WORD h FAMI-LYJMICIJE

Document e

®INC I U d - ta g fo @ NOTICE THAT WE WILL NOT RESPOND TO FAXED REFILL REQUESTS

Patient’s Name &
DOB

Due to the recent marked increase in the number of computer generated fax requests from

m % u n & F a X t h e all pharmacies, we will no longer respond to them.
We have found many of them to be requesting medicines that are no longer on the patient’s
o P h a r m a C F a X current medicine list.
y Effective immediately, our office will respond only to refill requests that you initiate
' 4 electronically via SureScripts, since this allows us to review the patient chart with the
O I Cy e e r rO I I I request, and to respond to your request in a timely manner.
. a t i e n t ’S C h a rt In the future, please do not fax refill requests to us, as we will not be r ing
Section]/ *agel s Linel Call MUK - e

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize Vacation Coverage RX Workflow —
Refill e-scripts for Partners Quick & Easy via
“Assign Refill RX” (& reassign scripts received in error)

m Staff can assign refills to covering provider (except EPCS — need TE)

= Caution — Refill Request does not disappear from 1t doc’s list
until addressed by 2" doc

. ePrescribe Rx

Patient Name

Patient Address J
DOB : 1954-10-31 I
Last Appt: 0z

Formulation  tablet

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize Your Notes Even Further —
Don’t Just Document Visits with Words
- One Picture is Worth

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use eClinicalMobile to Add Photos
to Your Visit Notes

-qugs,Wllllam Cw SChEdUle

SUNDAY, 09 OCT 2016
My ODM Test, Wcb Development >
11:00 AM i 11:00 AM §
William C Biggs M | | William C Biggs MD .
" Diabetes

Test, Julia » by oom Test, Julia »
11:15 AM 11:15 AM

William C Biggs MD

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Choose an Award Winning Photo
Already Saved on your Phone
or Shoot from Camera

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




eClinicalMobile Photos
Automatically Get Inserted Into Visit Note

Lab Reports:
Preventive Medicine: =
MNext A intment:

Billing Information:

mPhotos are full size at
bottom of visit note s

= ncluded when notes are
printed or faxed

mGet saved as a Document
In Patient Documents
Folder

eClinicalWorks Bradley M. Blok, M.D. -- Wi||iam “eddy” Biggs, M.D.




Yet More Tips for Completing Notes

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Try the New “Orders” Screen
to Edit Visit Treatment Notes

"Quickly scrol

Medical Summary | Alerts | Labs | DI | Procedures | Growth Chart | Imm/T.Inj | Encounters | Patient Docs || Flowshee

through : L

Assessments list to b
find ones missing

notes or to

update/edit TX zo |
“Notes” or “Clinical e

Notes” e e T S L O oo

="Pen |con opens up
TX notes screen w/
Browse button

WOrSEens or ists for Podiatry referral

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use Problem List to
Update Medical HX on the Fly

"One click copies any DX from Problem List screen
to bottom of Med HX screen (& HX item can be edited)

"Has to be performed in an unlocked visit note or in

a TE w/ an open virtual visit

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize Patient Engagement with the
Portal & Healow

LOGIN TO YOUR ACCOUNT

We will send verification code to confirm access to this
number. Standard text messaging rates apply.

Welcome tO Using Mobile Phone  [J
Welcome to the Block, Nation, Chase & Smolen Patient Portal

nvenient 2 the comfort and priv office. remember that the

Book an appointment with your doctor
Ac - health records through the healow (§)
healow mobile app

Sort By irst Name

OR

Enter the details below

Find us using our unique practice code on the
healow app

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Maximize Use of Portal Messages
from Patients to Coordinate Care
Between Visits

"Have patients send you Blood Sugar or BP or
other Logs (manually entered)

mRespond to Patient to adjust care

"Update Med Dosing in RX Screen of Web
Encounter

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize Portal Message Workflow to
Maximize Use of Portal by Patients

®Turn on ltem Key so patients can “Reply” to
Web Encounters & Portal Messages

"|mproves efficiency - Avoids callbacks if patients need
further clarification or want to provide confirmation

="Not overused by patients - usually only get replies that
would have been phoned in to staff or sent via a new
portal message (and a few thank-you’s)
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Portal Message “Replies”

mRecognized by “RE:” in Reason

®Original Message appears in “Message” box
below new message for easy review
(Below dotted line)

" \More efficient than a new message

AssignedTo
n Block, Bradley M
n Eligibility Check
Rx | Lahs;"DIl Notesl Addendum | Log Histurvl Yirtual Yisit

Block,Bradley M, M.D. 09/25/2015 11:26:43 PM =

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Advocating Portal & Healow Benefits Your
Office & Your Patients

& Improves Satisfaction with Patients

Reason

AssignedTo
|thanl-c you

|v| |BI|:||:I-c:, EBradley M ﬂ

Nutesl Addendum] Log Histuryl Virtual "Jisitl

Addressed To: Dr. Block

Thank you
are ready.  Amazing... v

v Perform Eligibility Check
Message | Rx l Lahsfﬂll

for tour fast response. I just got a call from CWS. My scripts

Action Taken Reply to patient Action Taken ||| Check 51

Reason

AssignedTo

||:|Iac.5|1,rJ the iPhone access is awesume*vl IE-I::n:L:, Bradley M j

[T Perform Eligibility Check
HESSEH_II'El Rx |Lah5,,|l’DI|

Nutesl Addendum | Log Histurv_.rl ¥irtual 'ln'isitl

Message Complaints ||| Browse
See, this is one of the reasans I really like this practice. Up 2 date with technology, processes,
procedures, medicines, and general knowledge about new diagnostic technigues and treatments!

fwesome that we patients can finally see what the doc *really* said instead of what we thought we
heard!

Just wanted to give big kudo's to the decision makers,

S cClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Web Enabled Patient Stats
for Patients Seen in Past Year

Dr Block’s owRBEERIEERTS = 9595 (hewborms o7 yis)

Dr Bigg’s own Patients = 92%
Dr Block’s Family Medicine Group = 94%
Dr Bigg’'s Multi-Specialty Group = 76%

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Be a Star Performer in Your ACO
& Insurance Networks & MACRA

>\l
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t Data through 3.31.16
Som (NS) | Diabetes Care (NS)

“_““_““_ __ ““_““ ““ “W ,“7 ““_ ull

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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mCare of Cardiac Patients
Vaccination Rates

"|Influenza & Pneumonia
®Depression Screening
"Chlamydia Screening

"Mammogram Rates
®Colon CA Screening




The Key to Success —
Use eCW to Implement Changes

mCDSS, Classic Alerts, Clinical Quality Worksheets
"Pick one format - Train Staff & Providers to use this

=One click from Visit notes, TE’s, HUB to see all due &
overdue care items

Classic Alerts  alens|

o
o Q
o
o
v
v
o

Overview | DRTLA | History ‘ CD55
Test, Adiel 81 ¥, M as of 10/09/2016
B Global Alerts

! Clinical Quality Worksheet
|
Pending

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Where to Get Started —
Customize CDSS & Classic Alerts

=Create “Generic Practice Alerts” based on DX,
RX, and Age based Vax, Lab, DI, Procedures &
other QOC Performance Tracking Measures

Dx Specific Alert

Update Name |E11 i New | gpdate| Delete

[Mame ___ _ [Descripion ___ ____ [WebReference

Diabetic Care E)escription |Diabetic CarEJ Pneumococcal-23 {Adi Pneumococcal-23 =80 yrs o hitp:/ fwww.cdc.gov /v

Diabetic Care Prevnar (#1) dose 1
Vitamin B12 Deficiency Order Set |Diabetes and Renal Prevnar (£2) dose 2

Vitamin D deficiency Prevnar (£3) dosze 3
Hypertension Care

Prevnar-13- Pneumoc Prevnar-13 at 65 yrs old http:/ /www.cdc.gov /v
rts New Update . . .
CAD Care Ale Q Q Rotarix - Rotavirus® { Rotavirus #1

Heart Failure Web Reference Rotarix - Rotavirus* (i Rotavirus £2
Emphysema Care -HEMOGLOBIN A1C  Labs 3 Months TDaP-Adacel/Boostrix: TDaFP Booster
COPD Care -Lipid Panel (TChol,Tri Labs 1 Year Varicella Vaccine® Varicella £2
Asthma Care . . . . . .

-urine Random microa Labs 1 Year Varicella Vaccine® Varicella #1
RAD/Bronchspasm Care . .
Osteoporosis Monofilament Foot Tes XRays 1 Year Zostavax - Shingles Vi Zostavax =60 yrs old
Osteopenia Retinal Eye Exam for [ XRays . 1 Year
Fam HX Colon CA Colonosco Influenza age 3 & ove Immunizat 1 Year

Asplenia Pneumococcal-23 (Ad. Immunizat = DI Alerts e

RETIMAL PHOTOS HRays 1 Year
Find New | Update | Delete
[Name — [Descripon  [Web Reference

Lab Alert % Colonoscopy Colonoscopy 50-85 yrs http:/ fwww.aafp.ora/
Depression Screening Depression Screening 11-10 http:/ /www.aafp.org/:

DEXA BONE DENSITY DEXA in Men over 89 http: / /www.rheumatol
Find | Mew | Update | Delete DEXA BONE DENSITY DEXA in Women over 54 http:/ /www.rheumatol

[Name ____ [Descripon _______[WebReference i eaemogrem Screet 4978

. Medicare Annualwellne Medicare Annualwellnessvis
—C.HLTG«M)'N.GC, APTIM: CHLAM/GC Screening 16-24 http:/ fwww.usprevent PE (Well Physical Exan WCV
-Liguid Pap, CT/GC, w Paps 21-29 yrs old https:/ /www.acog.org PE (Well Physical Exan WCV/WTV
-Liquid Pap-And High-f Paps 30-65 yrs old https:/ /www.acog.org FE (Well Physical Exan PE young adults
-P3A4A , serum (refriger -PSA Men 50-70 http:/ fwww.aafp.org/) PE (Well Physical Exan PE (annual)=40y/o

PE (Well Physical Exan WBW
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Resources for Choosing Alerts

= Use National Guidelines —i.e.- USPSTF,
AAFP AGOG, AARTAAGE" "

mGet QOC Lists that providers will be judged
on from insurance plans

Performance metrics: Historical information about your practice
(Note: The information below includes data for the following products: MA PFFS and MA PPO
members.)

Denominator
Numerator (all patients Practice Practice
(patients with eligible for 2015 target
Measure service completed) service) performance performance
Breast.cancer 7 100.0% 81 percent
screening or greater
Coloref:tal cancer 31 89.0% 65 percent
screening or greater
Comprehensive
Diabetes Care- 13 93.0%
Nephropathy testing
ﬂigh-risk medications 2.0% 7 percent
in the elderly or less
Alc control — 86 percent

: 86.07
diabetes 5 fib or greater

94 percent
or greater

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use Alerts for Reminders when Care is Due

= Train Providers & Staff to Check Alerts or CQW
Every Visit — Need to make it a habit

"Use Registry or Alert Recall Function to
Generate Patient Lists to send Portal &
Messenger Reminders —i.e.- Flu Vax’s,

PE’s/Paps, Diabetic Care, Colonoscopies |

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Example - Use eCW PHQ-9 Smart Form
for Depression Screenings

=" Annual Depression Screening recommended for all patients > 10
vears old and tracked by P4P programs

= Nurses use DI Alert to track when due & Use a Template to insert
DX & CPT codes & DI tracking order

= Covered by insurance as “free preventive care”
w/ DX: Screening for Depression - Z13.89 (for M/C use: Z00.00 or Z00.01)

= Boosts practice income while boosting quality scores — we get $8-
$20 w/ CPT code: 99420 Health Risk Assessment Test (M/C use: G0444 -
Annual Depression Screening) — literally covers cost of hourly nursing payroll

ENT HEALTH QUESTIONNAIRE (PHQ-9)

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Keep your Diabetic Patients Up to Date
with Retinal Eye Exams

=\Welch Allyn
RetinaVue Camera
simplifies &
automates taking
quick & easy Retinal
Photos in office

" mprove Quality
Performance Scores

for ACO & P4P
g Programs
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Retinal Photos Made Easy

. P h OtOS get U p | Od d e d Welcl\A]lyn RetinaVue ™ Network
e k Diagnostic Report
fo r reVI eW by Ret I n a | Patient Information

Name: Exam Date 9/29/2016
Medical Record Number: 2225 Report Date:  9/29/2016

Specialist

Referring Physician: Bradley Block, MD
Referring Clinic: Block, Nation, Chase & Smolen Family Medicine

— D OW n | O a d P D F re p O rt Retinal Image Assessment and Management Plan
into patient documents — ‘ '
in eCW

®Qur cost per photos per
patient runs 32-39% of
g Diagnosis for Left Eye (0S): Diagnosis for Right Eye (OD):
rate re I m b u rS e d No diabetic retinopathy No diabetic retinopathy

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use eCW “Letters”
to Improve QOC Reporting Efficiency

= Create Letters staff can fax
other providers to obtain
specific medical care PROCITATION, AT, & SMIOLER
documentation for ACO & P4P 5.0 . o
programs — ie- written
specifically for DM Eye Exams,
Mammograms, Colonoscopies

= Jse “Tags” to Fill in Patient
Name & DOB |

Florida Statute Section 456-057(7) records may be released without signed authorization to
health care practioner’s involved in the care or treatment of the patient.

=mRun Letter & Fax in just
seconds

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Tips for Alert Success

=Stir up competitive nature of providers & staff
- show them how they compare with each

other —use MAQ Dashboards, eCW “Quality
Measures”, eBO reports, P4P Score Cards

1 Jse |nsurance!Scerer€ard results to make

changes in workflow to boost future scores

Reporting Interval
LI,/ #8 Reporting End Date

Reporting Begin Da




Alerts Pay Oft

=1 QOC & AWV scores in M/C ACO |
=" High QOC scores for other plans
" Consistent Performance Bonuses

D Bige's Practiil om

» Block, Nation, Chase &S.. @785 -

= High Performer with multiple insurance plans
=" CQW Alert Data helped with insurance negotiations
=" Helped ACO to get multiple Commercial Insurance Contracts

= All Offices:

" Extra Income from services performed (espec M/C AWV)

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Patient Safety Protocols
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Reduce Patient Medication Errors
& Improve Compliance
— Customize & Use Visit Summaries

" Print VS for complex med lists,
med changes, & espec for pts W/ Dz
poor medical comprehension eaafs g B 0 0w

Medication List
| U d 1+ 1 Pl B | d « Stop Toujeo : 300 units/mL 30 units daily & increase dose every 4 days as
S e e | t | n g O pt I O n S O ) needed to keep BS < 150 subcutaneously once a day,When Out of current supply,
stop date: 06/2 ;

U n d e rl i n e’ FO nt S i Ze, m a n u a | |y . ?{to}}l\-[ag_-(}x 400 : 400 mg 1 tab(s) orally once a day OTC, stop date:
06/22/2016
1 + Start calcium carbonate : 600 mg 1 tab(s) orally OTC once a day
ty p e | n O r C O p y/ p a St e C O m m e n t S « Start ";‘regll)l::(c\%ug:l:ui of Tt)::lgo):?zo;' U?fnL?;o 1u1i:;l§:i?3! :‘:‘increase dose
every 4 days as needed to keep BS < 150 as directed subcutaneous once a day,30

to emphasize important Gays.3%3 mL pens Reflls: 5

i ¥ « Start magnesium lactate : 84 mg 4 tab(s) orally OTC Daily as directed,OTC

I n fo r m at | O n + Increase Vitamin D3 OTC : 5000 intl units 1 cap(s) orally OTC once a day OTC
+ Increase lisinopril : 20 mg 1 tab for bp & potassium & kidneys orally once a
day,30 days ,30 ,Refills: 2

7 + Increase levothyroxine : 25 meg (0.025 mg) 0.5 tab in am as directed w/ the
- C U StO I I I I Ze VS tO I | I a ke EAS | E R TO 200 mcg tablet orally once a day,60 days ,30 Tablet .Refills: 1
+ Decrease Omeprazole : 40 mg 1 cap(s) orally twice a day; but trv once daily as

R EA D fo r S e n i O rS o a S k e CW %{:‘g&da}ﬁ 1,: 02,3){(‘)3%2;(;12 mg) 1 tab every AM w/ the other thyroid pill orally
S U p p O rt tO C h a n g e d efa U |t F O nt Ref a ng - ) for diabetic neuropathy & fibromyalgia & arthritis & mood
Size to “3” for all Meds in both « Refil Atoras

Med Listings
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Provide Patients Important Medication
Warnings with RX Education

"Don’t rely on patients
rememberlng alendronate

Promunciation: a LEN dro nate

everything you tell e e

What is the most important infermation | should know about alendronate?

Education for them ' '

=Circle (by hand) importantje=

wom

items on the print out

=Use Browse button e
Macro to insert chart

documentation if e
desired

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




|dentify Patients on Potentially
Dangerous Meds

=Subscribe to FDA &
Medscape News email
Alerts

=Use Registry “Current
Medication” search to
find patients on meds
with new FDA warnings &5
meds taken off market

=Send Message directly to
patients, Letters to mail,
or Print lists for staff

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Keep All Medication Allergies
in Structured Format

sStructured Format
N e C e S S a ry fo r A | | e r gy 5 Past P'i'1EI:|iCE_| i -.-'Il[...e.r'm:n,. F'ifir:n: I:a'1 - 09/17/2016 09:30 PM, Q)
Alerts to function '

properly

=Train All Staff & Providers
- Only use “Structured” [T
choices, AND FIX ALL

Elevated Liver Enzym Contraindication
ANAPHYLAXIS Allergy

“Non-Structured”
g Allergies in chart

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Don’t Let Failed Interface Results
Go MIA & Without Review

BB cstient Schedule EMR Biling Re

=\Watch for Lab & Radiology
results which failed to match

up with patients

"(Go to File> “Reconcile
Interface Results”

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Find Missing Results Quicker - Customize
yvour Interface Reconciliation Settings

mceCW Support can change default search
timeline from default of 1 day to the past 1
month or 1 year

Interface Reconciliation -

Interface Reconciliation | TobeRecondled  Reconcied

- Received Between  [EIEENCY
1P BT provider
nscription Documents | [ Dictation |

] Patient Name Patient DOB Provider

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Billing & Finances of the Past
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Billing & Finances of the Future
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Activate & Use ePayments for Patients
to Pay their Balances via the Portal

Latest Statem
Latest Statement ePayment

Patient Portal Billing Statement
PATIENT NAME IF PAYING BY CREDIT, FILL OUT BELOW. T eC||'n ica |Work5 epayme nt Gatewaﬂ

CHECK CARD USED
Patient M Demo .
[ 1 MASTER CARD [1VISA [ ] DISCOVER Patient

BILLING INFORMATION
Name on the card

Patient Demo E

BIEEEAEE LTI B CARD NUMBER AMOUNT PAID
05/04/2016

SIGNATURE: EXP.DATE:
Address 1 Address 2

2441 W SR 426 #2011

AMOUNT ENCLOSED:

THIS IS A STATEMENT OF SERVICES RENDERED BY
Patient M Demo PHYSICIAN(S) WHO ARE MEMBERS OF:

2441 W SR 426 Block,Nation,Chase,Smolen FamilyMed City State Zip Code
#2011 2441 West 5.R.426, Ste.2011

OVIEDO FL 32765-4515 Oviedo FL 327654515 OVIEDO FL 32765-45
407-678-6888

EQFEIEE DESCRIPTION OF SERVICE AMOUNT CARD INFORMATION
11/30/2015 Claim:211489, Provider: Bradley M. Block, M.D. DATE O SCIRE 5
! W aim: ¢ Froviaer: radley . ock, WL I 1 T 1
: . CiscoveR
11/30/2015 Office Visit, Est Pt., Level 3 - Units 1.00 SERVIC _WSA_ @ 'l‘m | el
05/04/2016 PAYMENT IS DUE UPON RECEIPT. (CURRENT) 11/30/2015
Your Balance Due On These Services ... 11/30/2015 vV What is Cvv? Expiration
05/04/2016 5 T 2016

DATE PATIENT NAME ACCT. NO. PAY THIS
05/04/2016 Patigaf Demo 70248 ARICILINT:

— _ : . A Amount in USD
This is a statement fow/ 5 MAKE CHECK Block, Nation, Chase & Smolen Family Ll

rendered by your phirs] % ’ i -
separate bill from th = L5 PAYABLE TO: Medicine 05/04/20 112.00

IMPORTANT MESSAGE REGARDING YOUR ACCOUNT Thisien oo
rendered by Email

g - separate bil
Statement Balance L docblockmd@yahoo.com

- $112.00
Pay Bill If you havejmade any payment towards this statement you will see it refl tion Logs'

nt Ba Make Payment

ill i
Pay Bi If

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Maximize Efficiency - Interface with
Collection Agency - TransWorld Systems

Look Up By |Co|lecti0n Cycle Name Filter ’— to ’—
Collection Cycle |C3 Balance ’—LI ’T Ex Status ,m
Collection Rule |Apply J I al ] Lookup

2 I L ame | Hy : |Current Cycle] Recent Activity | Status | External Status
81656 80.70 Final $79.30 on 01/29/2014 @ START
73514 158.00 Final $30.00 on 04/23/2014 @ START
83844 100.00 Final $30.00 on 05/16/2014 @ START

84180 Test, test Test, test 508-329-3337 0.00 Final

Add Patient Payment

Patient Account Inquiry

Print Patient Statement

Print ePatient Statement

Remove From Collection

Move To Different Collection Cycle

Upload START File Te TransWorld Collection Agency
Upload STOP File To TransWorld Collection Agency Records: 5, Page Balance: $561.70

25 1-5 v|of Srecords  Generate Letters | v Generate Collection Details For Selected Patients J

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Collection Agency Interface
Automatically Creates Billing Alerts

3 Billing Alert for ( TEST, COLE-FAKE )

[ BllllngAlert | Global Alerts Insurance Alert |
|  Show Billing Alert

Given to collection on: 10/14/2014

Current collection status: C3

Billing Motes  TimeStamp | Check Spelling

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Take Home Message

mCustomize Your Workflow in eCW
to Optimize Your Efficiency,
Documentation & Patient Care

"|mprove Patient Engagement &
Satisfaction

=Save on Staffing Costs & Boost Income
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Your Assignment and Thoughts for
Moving Your Practice Forward

mRefer to your notes & Implement the 3-5 Ideas
sShare wisdom throughout your group
= Try to develop on-site Super User(s)

="Choose some |leaders to participate in the eCW
Web User’s Forum: http://www.ecwusers.com/

"EMR, PM & Billing, MU, Portal, IT, eClinicalTouch...

USErs
nacy2
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Questions?

=Bradley M. Block, M.D.
=\William “Reddy” Biggs, M.D.

=For copy of our current & past presentations
& Dr Bigg’s Pharmacy Fax Letter go to:
http://blockandnation.com/blockandbiggs

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




